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A CHANGES AND ENHANCEMENTS MADE IN SEE ELECTRICAL EXPERT 
V4R3 SERVICE PACK 1 (4.81/D) COMPARED TO V4R3 (4.81/A) 

 
 

A.1. NEW FEATURES AND ENHANCEMENTS 
 
 

SEE Catalogue Utilities Tool 

▪ When the tool is launched, following the execution of the Tools ➤ Add or Modify field 

into multiple classes command in the Equipment Catalogue, the environment of the 
active project is automatically loaded by default (no more necessary to select it manually). 

 
 

"Channel" and "Line Group" symbols 

▪ Alphanumerical sorting of the pins in the CAD Properties dialogues of the "Channel" and 
"Line Group" symbols. 

 
 

Label Export: 

▪ Selection of a specific manufacturer format for the data extraction no longer mandatory – 
realized via the newly introduced "No Constructor" option. 

▪ In case a file is already open at the time of launching the export, a relevant message is 
displayed suggesting advising you to close the file before proceeding.  

▪ A progress bar displayed during the exportation process. 
▪ In case several manufacturer formats (constructors) were selected for the extraction, at 

the end of the process a single report window is displayed, grouping all export label 
results (instead of several separate windows appearing per particular manufacturers). 

▪ When data sort is set to be "by Sheet", the process takes into account the Sheets Groups, 
meaning that sorting by Group is run first, after which the sorting by Sheet (in the 
respective Groups) is performed. 

▪ Cable labeling is able to work with both formats available in the Export format cable 
frame within the General section of the Settings window: "Label" and " Location From – 
Label and Location To – Label"  

 
 
 

A.2. FIXED ISSUES 
 
 
Cut/Paste 

BM22274 Impossible to execute Paste if another operation/command is executed 
after Cut (Paste command becomes inactive - dimmed). 
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Connector 

BM23352 The synchronization of Connector and Black Box attributes does not 
work correctly. 

 
 
Environment Method 

BM23395 Signals Method: During the method validation, an error concerning 
signals of Cross-Ref category is generated. 

 
 
Harness Editor 

BM23381 The "Harness Links Visibility" icon is not present by default in the 
Visibility toolbar 

 
 
Installation 

BM23345 Impossible to launch SEE Electrical Expert V4R3 on a new computer. 

 
 
List Reports 

BM22599 A filter does not work if the respective catalogue filed has an empty 
value. 

 
 
Messages 

BM23209 Rename the command Release Notes, What's new in the menu <?>. 

BM23249 Physical Terminal "Symbol" dialogue in the Terminal Strip Editor.  

BM23252 French translation of a command in the Tools menu: Lancer Jigboard. 

BM23253 Version error in the SEE Converter dialogue. 

BM23254 In the French version, the SEE Converter dialogues are in English. 

BM23255 Message: "Export JSON file(s)" incorrect. 

BM23278 Incorrect translation in the Label Export tool for the German version. 

BM23297 "File > Import …" and File > Export …" modification. 

BM23314 Incorrect translation of a label exportation command in the French 
versiosn. 

BM605193 Wrong position of the text in the Symbol display settings from the View 
section of the Settings window. 

BM1300933 In the Terminal Strip Editor of the Spanish software version, change the 
description for the command "Borna/pin no insertados en esquema". 

BM1401506 Incorrect translation in the SEE Electrical Expert Configurator for the 
Italian version. 

BM1401537 Incorrect title and wrong position of a general setting. 

BM1401571 
BM1700110 

Incorrect translation in the Label export dialogue. 
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BM23322 
In the SEE Electrical Expert Configurator, incorrect French translations 
for the Log file settings.  

BM23335 
In the Format Definition dialogue, a text does not fit the size of the 
respective button. 

BM 23343 Several incorrect translations in the French version. 

BM23364 
Incorrect translations in the Protection Settings category of the SEE 
Electrical Expert Configurator. 

BM23369 Incorrect translation in Option&Variants 

BM23374 Incorrect Behaviours/Functions of symbols 

BM23377 
To correct the message displayed when Process > Automatic 
insertion of Harness Connective Equipment is launched. 

BM23378 Incorrect translation in the Harness method. 

BM23380 Message to correct in Harness Sheet. 

BM23382 
Incorrect translation of contextual command on equipment symbols in a 
Harness Sheet. 

BM23390 
Incorrect translation of the "Purge project during project closing" 
option in the General settings of the German version. 

BM23399 
Incorrect translation in the Protection Key category of the SEE 
Electrical Expert Configurator for the French version. 

BM1700112 
Incorrect translation in the SEE Electrical Expert Configurator for the 
Chineese version. 

 
 

▪ Label Export related messages 

 In the Settings and Label export dialogue windows, corrected some options / 
settings in order that better relevance, accuracy and texts consistency are 
achieved. 

 For the French version, corrected the translations of some texts (settings and 
options) in the Settings and Label export dialogue windows. 

 In the Plugins Manager section of the SEE Electrical Expert Configurator, 
corrected the names and descriptions of the plugins for label export. 

 
 
Protection 

BM23313 When the "Essential" bundle is used, it is impossible to open the CAD 
Properties dialogue of an inserted cable. 

BM23333 Impossible to launch SEE Electrical Expert right after specifying a 
"HASP local" protection type.  

BM23375 With a "Flex server" license, it is mpossible to use the Layout Editor. 

BM23287 With a "Hasp server" license, the SEE Electrical Expert Configurator 
crashes when switching to the Protection Key settings (in the Security 
section).  

BM23324 Possible to extract data from the database with a Simplified BOM. 
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Symbol Editor 

BM23264 
The text alignment to Right/Left of the displayed attributes is inverted 
(wrong) in their Text Properties windows . 

 
 
Translation 

BM23223 The case of some texts is not kept after their translation. 

BM23281 Some terms/texts that exist in the translation database are not 
translated. 

BM23361 While setting a translation into a New Project, in the dialogue for 
destination location selection it is impossible to open a folder via double 
click. 

 
 
 

A.3. KNOWN ISSUES AND WORKAROUNDS 
 
 

Issues to be fixed in V4R3 Service Pack 2 (4.82/A) 

 
▪ SEE Electrical Expert Configuration 

 In the Plugins Manager section, plug-ins are sorted alphanumerically. 
 

▪ Label Export 

 When the sorting mode is by "Sheet" or "Location", ability to sort alphanumerically 
the equipment. 

 Ability to sort terminals alphanumerically when the first sorting criteria is by order 
in Sheet Explorer. 

 Correction of the "Wire Label number calculation" (in the General settings) in 
order that it is able to work with both formulas: 
 "-Wires existing: Label number = Wire number * 2" 
 "-Wires not existing: Label number = (Equipment number * 2) – 2" 

 A new extraction works even if the settings have been changed since the previous 
extraction. 

 Ability to export all the equipment – with and without equipment codes. 
Ability to export all terminals even if they have the same equipment code. 

 Ability to export pins. 

 Process > Export SEE labelling Export File has to generate the file in the 
location indicated by the path defined in the "Files generated folder" frame within 
the Label Export settings window. 

 Correction of data repetition in files that are generated using the "Grafoplast" 
format. 

 Wires sorting able to sort correctly the wires on connections with OPRs. 
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2D Panel 

BM23186 The panel equipment code is counted twice in the Part List. 

 
 
Cables 

BM22239 "CODE" attribute does not display information at the first insertion of a 
cable. 

BM604715 The wire function is removed when changing the cable marker. 

 
 

DXF/DWG 

BM1602358 When importing a file, the lines are converted in splines. 

 
 

Electric Data Explorer 

BM22983 Wrong sorting of the Sheets that have numbers with index (when a 
complement format is defined for the sheet numbering format in the 
method). 

 
 

Environment Method 

BM22758 Wrong characters after validation of default attributes defined in the 
Attributes Method. 

 
 
Installation 

BM23106 Translation of a module name in Custom installation mode. 

BM23220 When French language is selected during the installation and then 
English is selected for running the software, the "Tips of the day" are 
missing in English. 

 
 

List Reports 

BM1601863 Filter not working on Terminal symbols. 

 
 
Messages 

BM23277 Incorrect translation of an option for the Update WD attributes and 
connection points of symbol process in the French version 

BM23308 Texts to be homogenized in the Protection Info category of the 
Technical Information window. 

BM23328 In the French version, incorrect translation of the tooltip to the icon for 
filtering harnesses. 

BM23344 In the French version, when an existing Equipment Code is entered in 
the Equipment Catalogue, the displayed message is in English. 

BM23347 Incorrect translations in the SEE Electrical Expert Configurator. 
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BM23418 Options not completely visible in the Connector and Pin Association 
for Insertion Method 

BM1300977 Incorrect translation of a message displayed at project opening in the 
Spanish version.  

 
 

Migration 

BM23130 Lost translation in a project migrated from V3R7 to V4R2. 

BM605173 After migration of a project from V3R7 to V4R2, the WD attributes on 
some OPR symbols are lost.  

 
 

Multi Language 

BM605195 The modification of the location description for a Location symbol is not 
propagated to the other Location symbols from the same location  

 
 

Multi-User 

BM1300953 In the Sheets tab of the Electric Data Explorer, the Sheets opened by 
another user are not displayed in red pen. 

 
 

Printing 

BM1401542 When printing the project in PDF format (i.e. generating a PDF file), 
some entities are missing. 

 
 
Protection 

BM23090 Impossible to change the software language when Internet License 
Server Protection is used. 

 
 

Schematic Editor 

BM23232 OPR symbols: When multiple OPR symbols are inserted, the WD 
attributes, which are to display the respective Source and Destination 
tags, have wrong values. 

BM23376 Channel / Line Group symbols: In the Properties dialogues of these 
symbols, it is impossible to enable the "Limited propagation" check 
box. 

BM605140 Dynamic zoom does not work when a command (from the Edit or 
Insert menu) is activated. 

 
 

Sheets Explorer 

BM23330 Functionality for displaying only texts and drawings: When the 
respective icon is activated, grouped entities or objects are not taken 
into account.  
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BM23420 Impossible to create a Location on a newly created Group. 

 
 

Synoptic Editor 

BM605149 When a prefix and/or a suffix is used in a symbol attribute, the 
respective value is printed twice (overwritten). 

 
 

Title Block 

BM23284 Incorrect Metacommand attributes list 

 
 

Translation 

BM23234 The list of the not translated terms is different depending on whether 
the database has been accessed (from the Translation window) before 
running the translation process on a project, or not. 

 
 
 

A.4. LIMITATIONS AND RESTRICTIONS 
 
 

 SEE ELECTRICAL EXPERT 
 
 
 SEE Electrical Expert cannot be run under Windows XP. 

 
 SEE Electrical Expert V4R3 Service Pack 1 (4.81/D) needs a Flex LM version that is equal or 

upper to 11.14.02 in order to use this type of protection. The "Visual C++ Redistribute for 
Visual Studio 2015" component has to be installed on the server where Flex LM is installed. 
Normally this component is automatically installed with the Windows Update. 

 
 Project maximal size is 1.8 GB. 

 
 The multi-language features of a project are protected by the "Translation" license.  

Editing texts or attributes is possible to be carried out in all project languages only provided you 
have the "Translation" module included in your license. 
If you do not have the "Translation" module, you are allowed to consult the project in each project 
language but you can make modifications in the "main" language only. 

 
 The migration process does not recreate the hyperlinks in projects created with V4R1 or 

previous versions of SEE Electrical Expert. To have the hyperlinks available on migrated 
projects, you have to rebuild the cross references and then generate the part lists and table of 
contents again. 

 
 PDF Export: To activate the hyperlinks in Adobe Acrobat Pro, click Edit > Preferences…, 

select the Documents category in the left pane of the displayed Preferences window  and 
then choose "Never" from the drop-down list available for the "View documents in PDF/A 
mode" setting. 
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 SEE Workspace (SWS files generated through Options/Customize - Export button) that were 

saved with versions lower or equal to V4R1 are not supported by V4R3. 
 
 SEE Equipment Database supports MS SQL Server 2008, 2012 and 2014 ("Part List Manager" 

license is required). 
 
 Versions greater or equal to V4 do no longer support MS SQL or Oracle database for the parts 

list processes. 
 
 If you are using Local Server Borrowing (LSB) or Internet License Server (ILS) Protection, it is 

impossible to change the software language after the installation. 
 
 
 

 SEE ELECTRICAL 3D PANEL  
 
 SEE Electrical 3D Panel has its own installer and is not installed with SEE Electrical Expert.  

 
 
 

 SEE AUTOMATIC DIAGRAM GENERATION MODULE 
 
 The SEE Automatic Diagram Generation module has its own installer and is not installed with 

SEE Electrical Expert. 
 This module is protected by a license. 
 The SEE Automatic Diagram Generation module needs MS Excel. It is compatible with the 32 

and 64 bits versions of MS Excel 2010, 2013 and 2016. 
 It is not possible to add variables in Block Param Editor for blocks of layout or harness. 

 
 
 

 CONCURENT ENGINEERING MODULE (MULTI-USER MODE) 
 
 The Concurrent Engineering module (Multi-User mode) works with MS SQL Server 2012 and 

2014 databases for project data storage. 
 The Concurrent Engineering module needs SEE User Access. 
 The Close project without saving functionality does not work in Multi-User mode (Concurrent 

Engineering module). 
 
 
 

 OPEN DATA MODULE 
 
 The Open Data module needs MS Excel. 

 
 
 

 END FITTING MODULE 
 
 To migrate the data stored (until V4R1) in cable attributes to the new extremity attributes in 

V4R3, the "End Fitting migration to V4R3 (4.80)" plugin must be installed and enabled. 
 



 
 

Release Notes 
COPYRIGHT © 2017 IGE+XAO. All rights reserved 

 

A.Changes and Enhancements Made in SEE Electrical Expert V4R3 
Service Pack 1 (4.81/D) Compared to V4R3 (4.81/A) 

Page 11 

 

 
 3D PANEL FOR SOLIDWORKS MODULE 

 
 The "old" 3D Panel for SolidWorks module is no longer supported by SEE Electrical Expert 

versions that are greater or equal to V4R3. 
 A 3D panel layout created with this module (before V4R3) cannot be migrated to the new 3D 

Panel module. 
 
 
 

 MACRO 
 
 To execute a macro in SEE Electrical Expert versions greater or equal to V4R3, you need to 

have a VBA version 7.1 32 bit (not 64 bit) installed.  
 
 
 

 SMARTEAM INTEGRATION MODULE 
 
 The SmarTeam Integration module of SEE Electrical Expert V4, V4R1, V4R2, and V4R3 

supports the SmarTeam releases V5R19 to V5R27. 
 
 
 

A.5. COMPATIBILITY WITH OTHER IGE+XAO PRODUCTS 
 
 

 SEE PROJECT MANAGER 
 
SEE Electrical Expert V4R3 Service Pack 1 (4.81/D) is compatible with SEE Project Manager V8R2 
SP 7 - Patch K or L, and V8R3 Patch C. 
 
 
 

 SEE ACCESS CONTROL 
 
SEE Electrical Expert V4R3 Service Pack 1 (4.81/D) supports only the version 4.50/E of SEE User 
Access. 
Customers using older SEE User Access versions have to migrate their databases via the SEE User 
Access Admin Tool. 
 
 
 

 SEE AUTOMATIC DIAGRAM GENERATION 
 
SEE Electrical Expert V4R3 Service Pack 1 (4.81/D) supports the version V4.80/A of SEE Automatic 
Diagram Generation. 
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 SEE ELECTRICAL 3D PANEL 

 
SEE Electrical Expert V4R3 Service Pack 1 (4.81/D) supports V1R4 Service Pack 1 of SEE 
Electrical 3D Panel. 
 
 
 

 SEE ELECTRICAL JIGBOARD 
 
SEE Electrical Expert V4R3 Service Pack 1 (4.81/D) supports the version V4R7 of SEE Electrical 
Jigboard.  
 
 
 

A.6. SYSTEM REQUIREMENTS 
 
 

 ADVISED SYSTEM CONFIGURATION 
 

For Mono-User Mode: 

▪ Microsoft Windows 7 Home Premium, Professional, Ultimate, Enterprise  
▪ 64 bits Operating System to be installed on a 64 bits computer 
▪ Processor: i3 class, 2 GHz. 
▪ RAM: 4 GB. 
▪ 500 MB of free disk space required for the installation. 
▪ In order to optimize the SEE Electrical Expert performance on your computer, it is 

recommended that you use an SSD hard drive 
▪ Graphic Card: 1280 x 1024. 

 
 

For Multi-User Mode (Concurrent Engineering): 

The requirements are different for the Server and for the Client. 
 
For the Server: 
▪ Microsoft Windows Server 2008 R2 64 bits or newer. 
▪ Microsoft SQL Server 2008 R2 (PROFESSIONAL version strongly 

recommended; EXPRESS EDITION version possible to be used, but with some 
limitations). 

▪ Processor: i7 class, 3 GHz. 
▪ RAM: 12 GB (+ 1 GB by client). 
▪ 200 GB of free disk space required for the installation. 
▪ LAN (Network Card): 1 GB. 
 
For the Client: 
▪ Microsoft Windows 7 (64 bits). 
▪ Processor: i3 class, 2 GHz. 
▪ RAM: 4 GB. 
▪ 500 MB of free disk space required for the installation. 
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▪ In order to optimize the SEE Electrical Expert performance on your computer, it is 

recommended that you use an SSD hard drive 
▪ Network Card: 1 GB. 
▪ Graphic Card: 1280 x 1024. 
 
 

For using the 3D Panel: 

▪ Microsoft Windows 7 Home Premium, Professional, Ultimate, Enterprise. 
▪ Processor: i5 class, 2 GHz. 
▪ RAM: 4 GB. 
▪ 1 GB of free disk space required for the installation, along with the 3D Parts 

library, provided by default. 
▪ Graphic Card: full support of OpenGl required, as well as 1 GB of dedicated 

memory. 
 
 
 

 WINDOWS COMPATIBILITY 
 
SEE Electrical Expert V4R3 supports: 
 Microsoft Windows 10 Pro (32 and 64 bits), as well as Microsoft Windows 10 Enterprise (32 and 

64 bits). 
 Microsoft Windows 8 and Microsoft Windows 8.1 (except for the RT version for mobile devices). 
 Microsoft Windows 7. 
 

Microsoft Windows XP is not supported by SEE Electrical Expert V4R3. 
 
 
 

 VIRTUAL SOLUTIONS COMPATIBILITY 
 
SEE Project Manager and SEE Electrical Expert are compatible with Microsoft App-V and VMWare 
virtual solutions. 
 

Microsoft App-V or VMWare 

 
No compatibility issues with these two virtual solutions. 
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